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Preface

The purpose of this document is to provide you with an overview of the possibilities
offered by SAP ERP Knowledge Modules and how to use them in Oracle Data
Integrator.

This document provides examples to help you understand how to achieve an ETL
project with Oracle Data Integrator, loading a Data Warehouse with data from SAP
systems, while validating data quality.

This project should take approximately 90 minutes to complete. You may save your
work in order to pause and resume at any point in the project.

It is recommended that you use Oracle Data Integrator before proceeding with this
guide. A good introduction to Oracle Data Integrator is the guide Oracle Fusion
Middleware Getting Started with Oracle Data Integrator.

It is recommended that you also review the SAP ABAP chapter of the Knowledge
Module Developer’s Guide for Oracle Data Integrator for more information about the SAP
ERP KMs.

This document is intended for developers and administrators who want to use Oracle
Data Integrator Application Adapters with SAP ERP systems using SAP JCo libraries,
as a development tool for their integration processes.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are
hearing impaired.

Related Documents

For more information, see the following Oracle resources:



»  Getting Started with SAP ABAP ERP Adapter for Oracle Data Integrator
»  Application Adapters Guide for Oracle Data Integrator

» Installing and Configuring Oracle Data Integrator

»  Developer’s Guide for Oracle Data Integrator

n  Connectivity and Knowledge Modules Guide for Oracle Data Integrator

»  Knowledge Module Developer’s Guide for Oracle Data Integrator

»  Getting Started with SAP ABAP BW Adapter for Oracle Data Integrator
»  Oracle Data Integrator Studio Help
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Conventions

vi

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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Overview of Oracle Data Integrator SAP ERP

Overview

Knowledge Modules

This chapter provides an overview of Oracle Data Integrator SAP ERP Knowledge
Modules.

This chapter includes the following sections:

Overview

The Oracle Data Integrator SAP ABAP Knowledge Modules provide integration from
SAP ERP systems using SAP JCo libraries. This set of KMs has the following features:

Reads SAP data from SAP ERP system
Loads this SAP data into Oracle or non-Oracle Staging Area

Reverse-engineers SAP metadata and proposes a tree browser to pick up only the
required metadata

This adapter includes three knowledge modules:

RKM SAP ERP: Its main role is to perform customized reverse-engineering of
SAP tables into ODI datastores (Models). The SAP ERP RKM is in charge of
connecting to the SAP System, which provides the SAP table's metadata
information, and transforming and writing the resulting metadata into Oracle
Data Integrator's repository.

The LKM SAP ERP to Oracle (SQLLDR) connects to SAP and retrieves data from
the SAP tables defined in the SAP Model. It is used in the mappings. The LKM is
in charge of loading source data from a SAP System to an Oracle staging area.

The LKM SAP ERP to SQL connects to SAP and retrieves data from the SAP
tables defined in the SAP Model. It is used in the mappings. The LKM is in charge
of loading source data from a SAP System to a non-Oracle staging area.

Overview of Oracle Data Integrator SAP ERP Knowledge Modules 1-1
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Setting Up the Environment

This chapter describes how to set up your SAP ERP environment for use with Oracle
Data Integrator.

This chapter includes the following sections:

= Before You Begin

= Validating the Shared Folder Setup

= Validating the FTP Setup

= Validating SAP Privileges

= Validating SAP Transport Layer Name

» Installing Oracle Data Integrator

» Installing and Configuring the Oracle DB Target
» Installing and Configuring JCo

»  Setting Up an FIP Server

s Configuring Oracle Data Integrator

Before You Begin
Before you begin, consider the following;:
= System Requirements and Certification
= Getting the Right Privileges

s Gathering SAP Connection Information

System Requirements and Certification

Before performing any installation you should read the system requirements and
certification documentation to ensure that your environment meets the minimum
installation requirements for the products you are installing.

The Oracle Data Integrator requirements are listed in the Installing and Configuring
Oracle Data Integrator.

The requirements specific to the Oracle Data Integrator SAP ABAP Adapter are:
s Oracle Data Integrator 11.1.1.7.0 or above.

Setting Up the Environment  2-1



Before You Begin

Note: Most of this documentation also applies to the SAP
connectivity in Oracle BI-Applications, which requires Oracle Data
Integrator 10g, as specified in more detail in System Requirements and
Supported Platforms for Oracle Business Intelligence Applications for SAP.

= A Java Connector (JCo) version compatible with adapter must be used. The list of
supported JCo versions is available in the Certification Matrix available from
Oracle Technology Network (OTN). A minimum version of JCo 3.0.2 is required.

= A JVM version compatible with both Oracle Data Integrator and JCo must be used.
A minimum version of JVM 1.5 is required due to JCo pre-requisites.

s The connector supports two transfer modes for transferring data from SAP system
to the ODI agent: data transfer using a Shared Directory and data transfer through
FTIP. For details and restrictions see Section 8.7.1, "File Transfer Considerations" of
Application Adapters Guide for Oracle Data Integrator. Depending on the chosen file
transfer mode the following requirements must be met:

— Data transfer through a Shared Directory (recommended transfer method)
The LKM SAP ERP to Oracle (SQLLDR) requires a folder that is shared
between the SAP system and the ODI agent. The SAP application server
transfers the data by writing it out into a folder that is accessible from the SAP
system and the ODI agent machine. This is typically done by sharing a folder
of the ODI agent machine with the SAP system. Note that the shared folder
does not necessarily have to be located on the ODI agent machine. A shared
folder on a third machine is also possible, as long as the shared folder is
accessible to both the ODI agent machine and the SAP system.

Note: For security reasons, the SAP folders should not be shared
with the ODI agent. Share only folders of the ODI agent machine with
the SAP system.

The shared folder must be accessible to SAP system and not just to the
underlying operating system. This means that the folder needs to be declared
in SAP transaction AL11 and the folder opens successfully in AL11.

- Data transfer through FTP LKM SAP ERP to Oracle (SQLLDR) requires a FTP
server to upload data from the SAP ERP system. This data is either read
locally by the agent executing the mapping (when this agent runs on the FTP
server machine), or remotely (when this agent is located on a different
machine than the FIP server). This FTP server must be accessible over the
network from both the SAP ERP machine and the agent machine.

s For LKM SAP ERP to Oracle (SQLLDR) only: SQL*Loader is required on the
machine running the agent the executed mappings using LKM SAP ERP to Oracle
(SQLLDR). SQL*Loader is used for loading data extracted from SAP to the Oracle
staging area.

Getting the Right Privileges

The SAP Adapter requires privileges to perform set up and execution operations.
Please provide your administrators with the list of privileges listed in Appendix A,
"SAP ABAP ERP Required Privileges." These privileges are required for the SAP user
that they will provide you to login the SAP System.
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Gathering SAP Connection Information

In order to connect to the SAP ERP system, you must request the following
information from your SAP administrators:

SAP ERP System IP Address or Hostname: IP address/ Hostname is the technical
name given to the host on which SAP is running.

SAP User: SAP User is the unique user name given to a user for logging on the
SAP System.

SAP Password: Case-sensitive password used by the user to log in.

SAP Language: Code of the language used when logging in For example: EN for
English, DE for German.

SAP Client Number: The three-digit number assigned to the self-contained unit
which is called Client in SAP. A Client can be a training, development, testing or
production client or represent different divisions in a large company.

SAP System Number: The two-digit number assigned to a SAP instance which is
also called Web Application Server or WAS.

SAP System ID: The three-character, unique identifier of a SAP system in a
landscape.

SAP SNC Connection Properties (optional) SAP Router String (optional): SAP is
enhancing security through SNC and SAP router. It is used when these securities
are implemented.

SAP Transport Layer Name: This string uniquely identifies a transport layer in a
SAP landscape. It allows ODI to create transport requests for later deployment in
SAP. Even though there is a default value here, this transport layer name must be
provided by your SAP Basis team. Not doing so may result in significant delays
during installation.

SAP Version: The version of the SAP system.

SAP Character Set: The character set is only required if your SAP system is not a
UNICODE system. For a complete list of character sets, see "Locale Data" in the
Oracle Database Globalization Support Guide. For example, EE81S08859P2 for
Croatian Data. For UNICODE systems, use UTF8.

Note: All the connection data listed above (except SAP SNC
Connection Properties and SAP Router String) are mandatory and
should be requested from the SAP Administrators. You may consider
requesting support during connection setup from your SAP
administrators.

Validating the Shared Folder Setup

Validating a shared folder setup applies only if you plan to transfer data using a
Shared Directory. This section can be skipped, if the FIP transfer is used. The
validation of the shared folder setup needs to be performed before any subsequent
steps in this guide can be performed. This validation is typically performed by your
SAP Basis team.

Step 1: Validating folder access from the SAP application server

1.

Start the SAPGUI.
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Use the ODI SAP user and password to connect to the SAP system and client.
Go to transaction AL11.
Select the shared folder.

a k& ® N

Double-click the shared folder to test the directory declaration.

This should report a successful connection. If not, please contact your SAP basis
team. Do not continue until this test passes.

Note: SAP uses the OS user <sid>adm to connect to the directories
declared in AL11.

6. Print screen.

Step 2: Validating folder access from the ODI agent machine

1. Log in to the ODI agent machine using the Windows user ID used for executing
the ODI agent.

2. Open shared directory path in Windows Explorer.

This should list the content of the shared folder. Please make sure that you do
NOT need to enter any credentials. If this does not work or you had to enter
credentials, please contact your windows administrator or the system
administrator of the system your shared folder is physically located on. Do not
continue until this test passes.

3. Print screen.

Validating the FTP Setup

Validating an FIP setup applies only, if you plan to transfer data using FIP. This
section can be skipped, if you use a Shared Directory for the data transfer. The
validation of the FIP setup needs to be performed before any subsequent steps in this
guide can be performed. This validation is typically performed by your SAP Basis
team.

Step 1: Validating SAPFTPA destination
1. Start the SAPGUI

2. Use the ODI SAP user and password to connect to the SAP system and client.
3. Go to transaction SM59.

4. Expand TCP/IP connections.

5. Open the SAPFIPA destination.

6. Click Test connection.

This should report a successful connection. If not, please contact your SAP basis
team. Do not continue until this test passes.

7. Print screen.

Step 2: Testing FTP connection
1. Go to transaction SE38.

2. View the function module RSFTTP002.

2-4 Oracle Fusion Middleware Getting Started with SAP ABAP ERP Adapter for Oracle Data Integrator
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Hit F8 to run the ABAP program.

Enter the FIP userID and password.

Enter the FTP server host name or IP address.
Enter cd / or cd <ODI target directory>.

In the REC_DESTINATION field, enter SAPFTPA.
Hit F8 to run the test.

® N o g &

This should report a successful connection. The message should be similar to the
following:

250 CWD successful.

If this test is not successful, please contact your SAP basis team. Do not continue
until this test passes.

9. Print screen.

Validating SAP Privileges

This section describes how to test some of the key SAP privileges. Proceed with the
subsequent steps in this guide only after successful validation of these tests. This
validation is typically performed by your SAP Basis team.

Perform the following steps to validate whether a SAP user has appropriate dev rights
and owns a dev license key:

1. Start SAPGUL
Use the ODI SAP user and password to connect to the SAP system and client.
Go to transaction SE38.

2
3
4. Enter any sample program name like ZSAP_TEST in the program name field.
5. Click Create.

6

Perform similar tests for the transaction SE37 and SE11.

If a transaction allows the creation of a program without asking for any key or other
authorization message, then the SAP user has validated that it has the appropriate dev
rights and license key. Otherwise your SAP basis team needs to register the SAP user
in service.sap.com to get the license key and a Basis person can help him with dev
rights.

Validating SAP Transport Layer Name

As the SAP connector creates SAP objects, such as, for example, function modules, into
the SAP development system, these changes need to be transported into QA and
production systems once the development is done. The SAP's change and transport
system uses the SAP Transport Layer Name to identify the route a change has to take. A
transport layer is assigned to each development class and thus to all objects in that
class. The transport layer determines:

= In which SAP System developments or changes to the repository objects are made

= If objects are transported to other systems within the group when development
work has been completed

Setting Up the Environment 2-5
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A consolidation route is created from the development system to the quality assurance
system through the transport layer Z<SID>. It then becomes the standard transport
layer for customer development and customizing.

A consolidation route is created from the development system to the quality assurance
system through the transport layer SAP for the transport of SAP Standard objects.

It is important to specify the correct transport layer name before running the RKM
SAP ERP for the first time. Perform the following steps to identify the list of defined
transport layers in your SAP landscape:

1. Log on in client 000 in the SAP System serving as the transport domain controller
via transaction STMS.

2. Select Overview > Transport Routes. The Display Transport Routes dialog is
displayed.

Select Goto > Graphical Editor.
To switch the mode, select Configuration > Display <-> Change.

Position the cursor on the SAP System.

o a k w

Select Edit > System > Change. The Change System Attriburtes dialog is
displayed.

7. Select the StandardTransport Layer tab.
8. Change the transport layer of the SAP System.
9. The result is the list of the different transport Layers.

By default, the RKM option SAP_TRANSPORT_LAYER_NAME is set to SAP. Ask your
SAP basis admin which transport layer you should use. This transport layer name
must be set on the SAP_TRANSPORT_LAYER_NAME RKM option. A wrong or
invalid transport layer name will cause serious delays during the installation process.

Installing Oracle Data Integrator

Before starting with this project, you need to install and configure Oracle Data
Integrator. See the Oracle Fusion Middleware Getting Started with Oracle Data Integrator
and the Installing and Configuring Oracle Data Integrator for more information.

Installing and Configuring the Oracle DB Target

This project uses an Oracle database engine as the target and as the staging area for the
mappings. You can download for example Oracle Database 11¢g Express Edition from
Oracle Technology Network (OTN). Install and configure this database.

This project targets an Oracle table that can be created using the following script:

-- Create demo target schema

CREATE USER ODI_SAP_DEMO IDENTIFIED BY ODI_SAP_DEMO DEFAULT TABLESPACE USERS
TEMPORARY TABLESPACE TEMP;

GRANT CONNECT, RESOURCE TO ODI_SAP_DEMO;

-- Create demo target table

CREATE TABLE ODI_SAP_DEMO.W_GEO_DS (
LANGUAGE_KEY CHAR(20),
COUNTRY VARCHAR(50),
COUNTY VARCHAR(50),
STATE_PROV VARCHAR(50),
NATIONALITY VARCHAR(50));
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ALTER TABLE ODI_SAP_DEMO.W_GEO_DS ADD CONSTRAINT PK_W_GEO_DS PRIMARY KEY
(LANGUAGE_KEY) ;

Installing and Configuring JCo

The SAP adapter uses Java Connector (JCo) to connect to the SAP system. JCo must be
configured before proceeding with the project.

To install and configure JCo:

1.

Download a supported JCo version for your configuration from

http:/ /service.sap.com/connectors. Check the supported JCo version in the
Certification Matrix available at Oracle Technology Network. Note that a
minimum version of JCo 3.0.2 is required.

Notes:

»s  Choose the SAP JCo package matching your operating system and
your system architecture (32/64Bit). E.g. if you are running ODI
inside a 32-Bit JVM, you must download the 32-Bit SAP JCo, even
if the CPU and OS are 64-Bit. Mixing 32-bit and 64-bit architecture
is not possible due to native libraries required by SAP JCo and
will result in connection failure.

= odi.conf contains the JDK path used for ODI Studio.

Unzip the appropriate distribution package into an arbitrary directory
<sapjco-install-path>.

Follow the installation instructions in
<sapjco-install-path>/javadoc/installation.html for the respective platform.

Copy sapjco3.jar and sapjco3.dll:

For ODI 10g: Copy sapjco3.jar and sapjco3.dll (or respective binary like
libsapjco3.so) into the oracledi/drivers directory.

For ODI 11g: Copy sapjco3.jar and sapjco3.dll (or respective binary like
libsapjco3.so) into the <ODI_HOME>/odi_misc directory (ODI Studio) and into the
<ODI_HOME>/oracledi/agent/drivers directory (Standalone Agent).

For ODI 12¢: Copy sapjco3.jar and sapjco3.dll (or respective binary like
libsapjco3.so) into the <ODI_HOME>/odi/sdk/1ib directory.

Restart ODI Studio and any agents.
Check the JCo installation. This will be also checked later in this guide.

Setting Up an FTP Server

The SAP adapter extracts SAP data and uploads it to an FIP server. Configure an FIP
server or use an existing FIP server. You must create a user in this FIP server and a
directory into which this user will be able to upload files.
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Configuring Oracle Data Integrator

Perform the following steps to configure Oracle Data Integrator:

1. Set Up the Topology
2. Add the Open Tool
Set Up the Topology

Perform the following operations after installing or upgrading your Oracle Data
Integrator version:

1.
2.

Connect to Topology Manager.

If this SAP ABAP technology does not exist in your Master Repository, import the
SAP ABAP technology in Synonym INSERT_UPDATE mode from the /impexp
folder.

Perform an upgrade of the Master Repository. Refer to the Installing and
Configuring Oracle Data Integrator for more information on the Master Repository
upgrade process.

In Topology Manager, open the JavaBeanShell technology and check on the
Language tab that the JYTHON language is listed. If not, add it.

Create a File data server pointing to an existing FTP server into which the
extraction file will be pushed from SAP and picked up for SQL*Loader. Set the
parameters for this data server as follows:

s Host (Data Server): FIP server IP host name or IP address.
= User: Username to log into FIP server.
s Password: Password for the user.

For use with "LKM SAP ERP to SQL" these additional parameters must be
configured:

= JDBC driver class: com.sunopsis.jdbc.driver.file.FileDriver
= JDBC URL: jdbc:snps:dbfile?ENCODING=UTFS8

The above URL is for SAP UNICODE systems. For non-UNICODE system:s,
please see details on ENCODING parameter in section 3.3.1, "Creating a File
Data Server" of Connectivity and Knowledge Modules Guide for Oracle Data
Integrator. The encoding chosen on this URL must match the code page used
by the SAP Application Server.

In this File data server create a Physical Schema representing the folder in the FTP
host where the extraction file will be pushed. Specify the Data and Work Schemas
as follows:

= Data Schema: Path on the FIP server to upload or download extraction files
from the remote location. This path is used when uploading extraction files
from the SAP ERP system into the FTP server. It is also used by a remote agent
to download the extraction files. Note that this path must use slashes and
must end with a slash character.

= Work Schema: Local path on the FIP server's machine. This path is used by an
agent installed on this machine to access the extraction files without passing
via the FTP server. This access method is used if the FTP_TRANSFER _
METHOD parameter of the LKM SAP ERP to Oracle (SQLLDR)/ LKM SAP
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ERP to SQL is set to NONE. As Work Schema is an OS file name, slashes/
backslashes should be used according to OS.

Path names need to end on slash/ backslash. Path names given on Data and
Work schemas are not necessarily the same: the FIP service may provide
access to a FIP directory named /sapfiles while the files can be stored locally
in c:\inetpub\ftproot\sapfiles.

Refer to Section 8.7.1, "File Transfer Considerations" of Application Adapters Guide
for Oracle Data Integrator.

8. If the corresponding Logical Schema called File Server for SAP ABAP does not
exist yet, create it. This Logical Schema name is fixed and must be mapped to the
Physical Schema created in the previous step.

Add the Open Tool

The complete process of installing and adding an Open Tool to ODI is described in
Appendix A, "Oracle Data Integrator Tools Reference" of Developer’s Guide for Oracle
Data Integrator. This section details only the SAP ABAP specific steps.

1. Connect to Designer.
2. Select File > Add/Remove Open Tools...

3. Inthe Add/remove Open Tools window, enter the following name in the Open
Tool class name field:

oracle.odi.sap.km._OdiSapAbapExecuteStoppable
4. Click Add Open Tool.

5. The Add Open Tools window appears as shown below.

oy Add Open Tools <

To add an OpenTool, please add vour OpenTool's JAR or ZIP files to ' <ide.user.dir >Joracledijuserlb’ folder, then restart Oracle
Data Integrator, Please find <ide,user.dir > property in Properties tab of Help|About section.

Open Tooal class name: “;' ]

L c|ass ]I

% _0diSAPAbapExecute "-UPLOAD =<upload option>" "-EXECUTE=<execute option>" "-EX

“Provider Oracle.
This Open Tool will upload an ABAP program and also Extracts the data from SAP Systems, Version  10.1.3.16
To delete this Open Tool, dick Delete, Delete
Help oK Cancel
6. Click OK.
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Configuring the Topology

This chapter describes how to configure the topology by using a practical example.
This project will integrate the following source and target data:

Source tables T005T and T005U are the tables from SAP containing geographical
information.

Target W_GEO_DS is a dimension table in an Oracle database that needs to be loaded
from the SAP Sources. This table contains geographical information such as Continent
name, Country name, Region, State, County, City and Zip code.

This chapter includes the following sections:
s Configuring the Target Data Server
= Configuring the SAP Source Server

Configuring the Target Data Server

This section describes how to setup an Oracle Data Server. Please use respective
settings when configuring a non-Oracle Target Data Server for use with LKM SAP ERP
to SQL.

1. Connect to Topology Manager.

2. In the Physical Architecture tree view, expand the Technologies node and select
the Oracle technology.

3. Right-click and select New Data Server.

4. Enter the data server Definition as shown below:
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™) oRACLE TARGET

Test Connection

Definition G
o5 Data Server
On ConneckiDisconnect Marne: |ORACLE_TARGET
Properti
FOperties Technology:
Datasources
Version Instance [ dblink {Data Server: |XE
Privileges Connection
Flexfields
User:  |ODI_SAP_DEMO
PaSSWDrd: FEEEEEEE R
[ ] DI Connection

Arraw Fetch Size: Batch Update Size:

5. Select the JDBC tab, and enter the JDBC connection information to your data
server as shown below:

™) ORACLE TARGET

Test Connection

Definition

1DBC IDBC Driver:  |oracle.jdbc. OracleDriver

On ConneckfDisconneck jdbcioracle:thini@localhiosk; 1521 15E
Propetties IDBC Lrl:

Dakasources

Make sure to change the URL to match your Oracle instance configuration.
Click Test Connection to test the connection to this data server.
From File menu, click Save.

Right-click the data server you created and select New Physical Schema.

© ®» N O

In the Physical Schema windows that appears, select the ODI_SAP_DEMO for both
Schema and Work Schema.

If you already have a Work Schema for ODI defined for this data server, you can
use it instead of the ODI_SAP_DEMO Schema.

10. Go to the Context tab.
11. Click Add and enter in the Logical Schema field the value ODI_SAP_DEMO.

12. From the File menu, click Save.

Configuring the SAP Source Server

The following topics describe how to configure the SAP source server:
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= Configuring the Data Server

s Configuring the Logical Schema

Configuring the Data Server

Except for the data server name, all the parameters that you provide while defining
the SAP Data server should be provided by the SAP Administrators. See "Getting the
Right Privileges" on page 2-2 for more information.

The SAP Adapter requires privileges to perform set up and execution operations.
Please provide your administrators with the list of privileges listed in Appendix A,
"SAP ABAP ERP Required Privileges." These privileges are required for the SAP user
that they will provide you to login the SAP System.

See "Gathering SAP Connection Information” on page 2-3 for more information about
these parameters.

1. In the Physical Architecture tree view, expand the Technologies node, select the
SAP ABAP technology.

2. Right-click and select New Data Server.
3. Enter the data server definition. Set the parameters for this data server as follows:
= Name: SAP_ERP. The name of the data server as it will appear in ODL
= Host (Data Server): SAP ERP System IP Address or Hostname.
s User: SAP User, as provided by the SAP Administrator.
s Password: This user's SAP Password. This password is case-sensitive.
4. Set the Flexfield values for this data server in the Flexfields tab:

= SAP Language: Code of the language used when logging in. For example EN
for English, DE for German.

= SAP Client Number: The three-digit number assigned to the self-contained
unit which is called Client in SAP. A Client can be a training, development,
testing or production client or represent different divisions in a large company.

= SAP System Number: The two-digit number assigned to a SAP instance
which is also called Web Application Server or WAS.

= SAP System ID: The three-character, unique identifier of a SAP system in a
landscape.

= SAP SNC Connection Properties: SNC Connection Properties. This parameter
is optional and can be left empty.

= SAP Router String: Router String. This parameter is optional and can be left
empty.

= SAP Character Set: The character set is only required if your SAP system is
not a UNICODE system. For a complete list of character sets, see "Locale Data"
in the Oracle Database Globalization Support Guide. For example,
EE81508859P2 for Croatian Data. For UNICODE systems, use UTF8.
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Note: This FlexField is only used with "LKM SAP BW to Oracle
(SQLLDR)". For use with "LKM SAP BW to SQL" please define the
character set using the ENCODING parameter in the file driver URL,
as described in "Set Up the Topology" on page 2-8 for non-UNICODE
SAP systems.

= SAP ABAP Version: Enter the SAP ABAP version as follows:
— For SAP 4.6C enter 46C
— For SAP 4.7 enter 620
— For SAP ECC 5.0 enter 640
— For SAP ECC 6.0 enter 700
= SAP BW Version & SAP ERP Version: unused in SAP ERP Connector.

5. From the File menu, click Save.

Note: The Test Connection button for validating SAP Connection
definition is not supported for this connection.

Configuring the Logical Schema
1. In the Physical Schema window, do not edit the Definition tab.

2. Select the Context tab, click Add and enter the Logical Schema name LOGICAL_
SAP_ERP.

 cpp_ERP_Default

Drefinition
Context
Version Conkext Logical Schema
s Developrment OGICAL_SAP_ERP
Privileges
Flewxfields

3. From the File menu, click Save.
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Creating a New Project

This chapter describes how to create a new Project for SAP.

In order to work with the data servers you have created, you must create a project and
import the appropriate knowledge modules for reverse-engineering the data
structures and integrating the data.

Creating a New Project

To create a new Project for SAP:

1. Connect to Designer.
In the Projects tree view click New Project.
In the Definition tab, enter SAP Demo for the Project name.
From the File menu, click Save to save your project.
Expand the SAP Demo Project, select the First Folder node.
Rename this folder to SDE_SAP_GeoDimension.
Right-click the SAP Demo Project in the Projects tree view.

Right-click and select Import > Import Knowledge Modules.

© ® N o a » 0 DN

Select in the File import directory the directory containing your KMs. By default,
they are located in the . . /impexp directory.

-
o

. Select the following KMs:
s IKM Oracle Incremental Update
s LKM SAP ERP to Oracle (SQLLDR)
= LKM SAP ERP to SQL
= RKM SAP ERP
= RKM SAP ERP Connection Test
11. Click OK to perform the import.
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Reverse-Engineering Data Models

This chapter describes how to reverse-engineer the Oracle target and SAP source data
models.

This chapter includes the following sections:
= Reverse-Engineering the Oracle Target

= Reverse-Engineering the SAP Source Datastores

Reverse-Engineering the Oracle Target
To reverse-engineer the Oracle data model:
1. Connect to Designer.
2. In the Models tree view, click New Model.

3. In the Definition tab, enter the model parameters as shown below:
|z Oracle Target
@ Reverse Enginesr | % Generate and deploy

Definition .
[z Model

Reverse Enginesr

Zontrol Mame: ZIZ'r'an:IEe Target
el e Code: |OR.C'.CLE_TF'.RGET
Journalized Tables
Services Technalagy: | Oracle
Markers Logical Schema: | ODI_SAP_DEMO
Mermo

. Action Group: | <Eeneric Ackion =
Version
Privileges Default Folder: |
Flexfiglds

Descripkion:

4. Inthe Reverse Engineer tab, select the Global context.
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|z Oradle Target
f@ Reverse Engineer | o Generate and deploy
Definition e e :

. (%) 5tandard () Customized

Reverse Engineer
Selective Reverse-Engineering Context: |Glnbal
Cantral Logical Agent: |L|:||:a| (Mo Agent)
Journalizing

Journalized Tables Types of objects to reverse-engineer

[] Synoreym

Services Table Wiew CQueue [ ] System Table
Markers
Mask: %o
Mermo
Yersion Characters ko Remove from Table Alias: |W
itk Table Alias macximurm length: |35
Flexfields

5. Click Reverse Engineer, and then save your model.

6. The WS_GEO_DS datastore appears in your Oracle model, as shown below.

= Madels -

% Diagrams
-5 Hierarchy

D TARGET _IMTERWAL_HIERARCHY

D TARGET _MAWIGATIOMAL_ATTRIBUTE
T W _ACCNT _YENDR_DS
Tw_GED_DS

Reverse-Engineering the SAP Source Datastores

To reverse-engineer the SAP Source datastores you need to perform the following

tasks:

1. Creating the Data Model

2. Validating the SAP Connection

3. Starting the Reverse-Engineering Process
This section also includes the following topics:
s Using the SAP Metadata Browser

= Reverse-Engineering Without GUI

Creating the Data Model
1. In the Models tree view, click New Model.

2. In the Definition tab, enter the model parameters as shown below. You must select
the SAP ABAP technology and the Logical Schema previously created (in our

example it is the LOGICAL_SAP_ERP Logical Schema).
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| SAF ERP SOURCE

@ Reverse Engineer | % Generate and deploy

Definition

2 Model

Reverse Engineer

Control Mame: :-F'.F' ERF SOLRCE
el Gode: |SP.F‘_ERP'_SOLIRCE
Journalized Tables
Sl Technology: |S.ﬁ.F' AEAP
Markers Logical Schema: [LOGICAL_SAP_ERP
Memo

: Ackion Group: | <iGenetic Action >
Version
Privileges Default Folder: |
FlexFfields

Descripkion:

3. In the Reverse Engineer tab:
a. Select the Global context.
b. Select Customized option.

c. Select the RKM SAP ERP Connection Test you have imported in the SAP ERP
Demo project.

Validating the SAP Connection

1. In the Models tree view, open the SAP ERP Source Model.

2. Click Reverse Engineer and confirm the start of the reverse-engineering process.
This process runs two tests:

= Establish a test connection to the SAP system and
= Validate the proper setup of SAP JCo by displaying the About dialog.

3. Ina few seconds, you should see the SAP JCo-About dialog as shown here:
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SAP Java Connector (JCo) n

C
I

THE BEST-RUN E-BUSINESSES RUN SAP w

SAP Java Connector (JCo)
Copyright (c) 2000-2007 SAP AG, All rights reserved

Java Runtime

Operating System: Windows XP 5.1 for x86

Java VM: 1.6.0_14 Sun Microsystems Inc

Java Codepage: Cp1252
Versions

JCo APL: 302 (2009-03-29)

JCo middleware name: NEWEINS

JCo middleware: 241

JCo middieware native; EGRERCE

Paths

JCo classes: CAProgram®e20Files\Oracleloracledi_101351wracleditdrivers\sapjcod . jar
JCo library: CProgram Files\Oracle\oracledi_10135oracledivdriversisapjco3.dil

[ cise |

Please verify the JCo version number (see "System Requirements and
Certification" on page 2-1 for more details) and verify that a path for the JCo
Library is given (.d11 for Windows). If this is not the case or you see any error
message in this about dialog, please review the SAP JCo installation, as described
in your SAP JCo package, and run this test again.

Note: Closing the JCo-About-Dialog will also close ODI.

4. Once you have validated SAP JCo installation, open ODI Operator.
5. In the Operator, expand the Reverse-Engineering session down to the task level.

6. Verify whether the task "Test SAP Connection" has been executed successfully. If
not, view the task details to identify the connection problem. The output of this
task must contain Successfully connected to SAP System. If not, the connection
test has failed and the connection problem must be analyzed before you continue.

Do not continue until you have successfully validated the SAP connection!

Note: If you want to validate the SAP connectivity independent of
OD], please see Appendix B, "SAP Stand-Alone Connection Test."
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Starting the Reverse-Engineering Process
To start the reverse-engineering process of the SAP ERP datastores:
1. In the Models tree view, open the SAP ERP Source Model.
2. In the Reverse Engineer tab:
Select the G1obal context.

a
b. Select the Customized option.

o

Select the RKM SAP ERP you have imported in the SAP ERP Demo project.

e

Set the USE_GUI KM option to Yes.

e. For first time RKM use only: Set SAP_TRANSPORT_LAYER_NAME to the name of
the transport layer your SAP basis admin has provided you with.

Caution:

= Pay particular attention to provide the correct value for the SAP_
TRANSPORT_LAYER_NAME option. If an invalid value is used during
the first time installation, a significant delay in the connector
installation may be caused.

s For first time RKM use only: If you are using a custom value for
KM options SAP_FUNCTION_GROUP_ODI_DEV and SAP_FUNCTION_
GROUP_ODI_PROD, these function groups must not exist prior the
first execution of the UPLOAD_ABAP_CODE and UPLOAD_ABAP_BASE
set to true.

= For first time RKM use only: If you are using a custom value for
KM options SAP_PACKAGE_NAME_ODI_DEV and SAP_PACKAGE_NAME_
ODI_PROD, these packages must not exist prior the first execution
of the UPLOAD_ABAP_CODE and UPLOAD_ABAP_ BASE set to true.

f.  For first time RKM use only: Set UPLOAD_ABAP_CODE and UPLOAD_ABAP_BASE to
true. After the first execution these values must be set back to false.

g. Set other parameters according to your SAP configuration. See the Application
Adapters Guide for Oracle Data Integrator for more information on the RKM
options.

From the File menu, click Save to save your changes.

Click Reverse Engineer to start the reverse-engineering process.
Click OK.

The Sessions Started Dialog is displayed.

Click OK.

Set UPLOAD_ABAP_CODE and UPLOAD_ABAP_BASE back to No.

© ®» N o o & w

For first time RKM use only: Validate in Operator that the session is now in status
running. If session has failed, please validate settings. Do not move on until all
installation steps have been completed successfully.
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Using the SAP Metadata Browser

As you have set the USE_GUI option to Yes, the RKM displays in the SAP Metadata
Browser the SAP objects organized in the tree view as shown below.

Note: In case that the below dialog does not show up, see ODI
Operator and ODI log messages for details.

Refer to section 4.7.6, "Log Files," in Application Adapters Guide for
Oracle Data Integrator for more details.

-—l% SAP betadata Browser EIIEI

Search
Table Mame: Short Descripkion:
Application Component; Package:

Search

SAF Metadata

£ 2 AC (Accounting - General)

- i85 AIL {Auto-ID Infrastruckure)

i AP (Application Platform)

22| BC {Basis Components)

25 BW (SAP Business Information Warehouse)
25 CA ({Cross-Application Basis Components)
2 CO {Controlling)

25 €5 (Customer Service)

i2i| EC (Enterprise Controling)

-2 EHS (Enwironment, Health and Safety)

i EP (Enterprise Portal)

22| FI {Financial Accounting)

25 FIN (Financials)

25 FS (Financial Services)

-3 HUG (Product Lifecycle Management {Cld))
23 ICM {Incentive and Commission Management)
25 IM (Investment Management)

25 IN {International Development)

25 15 (Industry Specific)

i KM {Enowledge Management)

25| LE {Logistics Execution)

25 LD (Logistics - General)

23 MM (Materials Management)

.
i

+

i

.

Cancel Reverse
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The Tree View

The SAP Modules are organized into a tree view. Only the SAP Modules available to
the current user are displayed. By expanding the tree view, you can see SAP tables,
and select those that you want to reverse-engineer.

Note that only the tables selected in the tree view are reverse-engineered.

-

-l.ﬁ AP Metadata Browser EI@

Search

Table Mame: Short Description;

|SADR3 s | e
Application Component: Package:

Search

-] E SADR12 (Address Management: Reserve table for communications numbers)
i-[] SADR13 (Address Management: Reserve table for communications numbers)
-] SADR14 (Address Management: Reserve table for communications numbers)
-] E SADRZ (Address Management: Telephone Mumbers)

-] SADRS (Address Management: Fax Mumbers)

-] SADR4 (Address Management: Teletext Mumbers)

-] SADRS (Address Management: Telex Numbers)

-] E SADRA (Bddress Management: EDI Table)

-] E SADRT (Bddress Management: Mail Figlds)

i-[] SADRE (Bddress management: ¥, 400 addresses)

-] SADRS (Bddress management: Soft*Switch numbers)

-] E SADRP {(Address Management: Personal Data)

-] SAIM (Central Address File: Address where-used list)

e[| L 1005 (Countries)

-] TO0S4 (Address routines)

-] TOOSE (Mame of address roukines)

-] [ To0sE (County)

[ ] L To0SF (County: Texts)

(v L TOnSM (Mame Formats)

-] E TOOST {Mame Format Fields)

-] TOOSS (Taxes: Region (Province) Kew)

-] TOOST {Country Mames)

-] TO0SU (Taxes: Region Key: Texks)

- [ 154¢ ¢Communication Methods (Business Address Servicesih

oy T oy R g Y oy RNy IO oy OO oy AU oy OO oy OO oy Y oy IO oy O g IO oy OO oy IO oy N oy O oy Y oy Y oy Ny Y oy [N oy N o |

Zancel Reverse

The Search Panel
The Search option group allows you search specific objects in the browser, based on:

= Table Name
= Short Description
= Application Component

= Package
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For the example project, the T005T and T005U country tables are used:

1. Enter T005T in the Table Name field and click Search to find the first table to
reverse-engineer. Select this table.

2. Enter T005U in the Table Name field and click Search to find the second table to
reverse-engineer. Select this table.

3. C(lick Reverse.

4. Oracle Data Integrator starts the reverse-engineering process on the selected
datastores. The reverse-engineered datastores appear under the Model.

Reverse-Engineering Without GUI

If you want to perform a reverse-engineering without using the SAP Metadata
Browser, you can enter the following parameters in the SAP ERP KM options:

s USE_GUI: No
s SAP_TABLES NAME : T005T, T005U

With this configuration, the tables will be reverse-engineered without displaying the
SAP Metadata Browser.

By using the appropriate KM options, you can also select a filter for the reversed tables
based on for example a SAP Module or a Package name. You can also specify a table
name mask in the Mask field of the Reverse tab to filter table names.

Refer to the Application Adapters Guide for Oracle Data Integrator for more information
on the RKM options.

Note: It is not possible to view the data in the SAP ERP tables from
Oracle Data Integrator.

What happens when you reverse-engineer SAP ERP tables?

First, Oracle Data Integrator uploads in the SAP system ABAP code allowing for
retrieving the SAP metadata. This RFC is uploaded only if the UPLOAD_ABAP_CODE and
UPLOAD_ABAP_BASE options are selected (these options are typically activated only
once). The ABAP programs are generated in the SAP function group given in the SAP_
FUNCTION_GROUP_ODI_DEV and SAP_FUNCTION_GROUP_ODI_PROD RKM options.

Once this code is set up on SAP, Oracle Data Integrator is able to retrieve the SAP
metadata and to display it in the SAP Metadata Browser. Selected metadata is then
reverse-engineered from SAP into the Oracle Data Integrator repository. The
repository only contains the description of the SAP metadata, and no data at all.

In addition to the table definitions organized and enriched with user-friendly
information, the keys and indexes definitions are also retrieved. The model appearing
in Oracle Data Integrator shows all the information required for performing
integration tasks on the SAP ERP Model.
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Creating and Running the Mapping

This chapter describes how to create and run the mapping.
This chapter includes the following sections:

»  Creating the Mapping

= Running the Mapping

Creating the Mapping

Now that the source and target data models are created, it is possible to create a
mapping to integrate data from the T005T and T005U SAP tables to the WS_GEO_DS
Oracle table.

To create the mapping, perform the following steps:
1. Create the Mapping

2. Define the Source and Target Datastores

3. Define Joins between Sources

4. Create the Mappings

5. Define the Mapping Flow

Create the Mapping
1. Open Designer.

In the Projects tree view, expand the SAP Demo Project.
Expand the SDE_SAP_GeoDimension folder.

2

3

4. Select the Mappings node.

5. Right-click and select New Mapping.
6

In the Mapping Definition tab, enter the mapping name: SDE_SAP_
GeoDimension.W_GEO_DS.

7. Save the mapping.

Define the Source and Target Datastores

To define the source and target datastores:

s In the Models tree view, select the WS_GEO_DS datastore from the Oracle Target
Model.
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Drag this datastore into the Target Datastore area of the Logical diagram. (Right
area of the Logical diagram)

In the Models tree view, select the TO05T Country Names datastore from the SAP
ERP Source model.

Drag this datastore into the Sources area of the Logical diagram.

Perform the same operation for the T005U Taxes: Region Key datastore from the
SAP ERP Source model. The Sources area of the Logical diagram should look as
shown below:

=] Default
* L] *
553 TOOST ] To0sU
= MANDT (D= MARNDT
o= SPRAS [l SPRAS
L ] L ]
= LAMD1 [ LAMDA
LAMD O~ BLAMD
MATIO BEZEI
L & L)
LANDXS0
MATIOSD
PRC_SPREGT

Define Joins between Sources

To create joins between the source datastores of a mapping;:

6-2

1.

In the Sources area of the Logical diagram drag the SPRAS attribute from the
T005T Country Name datastore onto the SPRAS attribute in the T005U Taxes:
Region Key datastore.

On the Create Lookup or Join popup, select Join and click OK. This defines the
first join on the Language Key identifier, as shown below:

[=] Default
| TO0ST | TOOSU
@=  MANDT @~  MANDT
G+  SPRAS @~  SPRAS
B=  LANDI 5| @=  LANDI
LANDX [ L= B~  BLAND
NATIO BEZE
LANDXS0
NATIOSO
FRQ_SPREGT

Drag the LANDI attribute from the T005T Country Name datastore onto the LAND1
attribute in the T005U Taxes: Region Key datastore. The join is extended with the
new attributes. In the Properties panel, you can see the join clause:
TO05T.SPRAS=T005U.SPRAS AND T005T.LAND1=T005U.LAND1

In the Properties panel, select Generate ANSI Syntax and Join Order options, and
make sure that the Execute on Hint option is set to Source as shown below:
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JOIM - Propertties
Q, Find @

= Condition

Default.TO05T.SPRAS = Default.To05U. SPRAS Default.TOOST.LAHD] = Default.TO0OSU.LAHD1
Join Condition:

Cross Makural
TOOST(TOOST) ™ O TOOSETOOS)

Jain Type:
ti Inner Jain

All rows paired by the join condition between TOOSTITOOST) and TOOSU(TOOSU)

Technical Description: | |

Generate AMSI Synta:

Jain Order: User Defined: |10 |

Execute on Hint: [Source i |

5. Make sure that table number of T005U is smaller than that of T005T. In 1:n
relationships the parent table has to be the first in a join.

Create the Mappings

To create the mappings of the target datastore:
1. Select the LANGUAGE KEY attribute from the target datastore.

2. Drag the SPRAS attribute from the T005T Country Names source datastore onto the
LANGUAGE KEY attribute of the target datastore.

3. Make sure that the Execution on Hint option is set to Source. The mapping should
look as shown below:

New Mapping | CB LANGUAGE KEY - Propetties

Q, Find
= Target
Default.TO05T.SPRAS
Expressian:
Execute on Hint: | Source i |
Fixed Execution Location: | v|

Technical Description: | |

4. Repeat this operation to perform the following simple mappings:
m W_GEO_DS.COUNTRY = TO05T.LAND1

m W_GEO_DS.COUNTY = TOO05T.LANDX

m W_GEO_DS.STATE_PROV = T005U.BLAND

m W_GEO_DS.NATIONALITY = TOOS5T.NATIO
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Define the Mapping Flow

To define the mapping flow:

1. Select the Logical diagram. The Flow diagram looks as shown below;

1" SOURCE_GROUP

“ LOGICAL_SAP_ERP_UNIT
"1") TARGET_GROUP

|
] @ OD_SAP_DEMO_UNIT
TOOST
3 ik B
—> AGED_DS
o DEFALLT . DS
=
TOOSU

2. In the target group, select the access point for the source group that contains both
the T005T and T005U datastores. This source group represents the source dataset
made up of two joined SAP ERP datastores.

3. In the Property panel, under Loading Knowledge Module, select LKM SAP ERP to
Oracle (SQLLDR) or LKM SAP ERP to SQL from the Loading Knowledge Module
drop-down list.

a. If you are using FIP for the data transfer, please set the FI'P_TRANSFER_
METHOD option to FTP. If the FIP server is installed on your ODI agent
machine, select NONE.

b. Leave other options as they are.

4. In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

5. In Property panel, under Integration Knowledge Module, select IKM Oracle
Incremental Update from the Integration Knowledge Module drop-down list.

6. Set the IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

7. From the File menu, click Save and close your mapping.

Running the Mapping
This section contains the following topics:
= Running the Mapping
= Review the Mapping Execution

= Review the Resulting Data

Running the Mapping

To run the mapping:
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1. In the Projects tree view, expand the SAP Demo Project
Expand the SDE_SAP_GeoDimension folder.

Expand the Mappings node.

Select the SDE_SAP_GeoDimension.W_GEO_DS mapping.
Right-click and select Execute.

In the Execution window that appears, click OK.

N o a Db

Click OK in the Session Started window.

What happens when you run the mapping?
First, Oracle Data Integrator creates an ABAP program that does the following:

» It performs the extraction of the data on the SAP engine. In this example, the
extraction joins the two source tables and then returns the joined resultset in an
extraction file.

s It uploads the extraction file into a FTP data server. This FTP host is specified via
the File Logical Schema called File Server for SAP ABAP. This Logical Schema is
mapped to a Physical Schema and therefore a data server in the given context. This
data server contains the connection information for the FTP host.

Then, the ABAP code is uploaded using the OdiSapAbapExecute tool. The ABAP
program is pushed into the SAP Function group given in the SAP_FUNCTION_GROUP
LKM option. This phase can be suppressed by setting the UPLOAD_ABAP_CODE LKM
option to No.

The ABAP code is executed also by the OdiSapAbapExecute tool. At the end of the
ABAP code execution, the extraction file is available in the FIP host.

The Oracle Data Integrator agent is able to download this extraction file from the FIP
host, or directly access it, depending on the FTP_TRANSFER_METHOD specified in
the IKM option.

Finally, when the agent accesses the extraction file, it uses SQL*Loader or a JDBC
Connection to load this file into the Oracle/non-Oracle staging area. The rest of the
integration process takes place within the Oracle/non-Oracle engine.

Review the Mapping Execution

To review the mapping execution:

1. Connect to Operator.

2. In the Operator, select the Session List tree view.
3. Expand the All Executions node in this tree view.
4. The latest session is the first entry of this list.
5

Double click the SDE_SAP_GeoDimension.W_GEO_DS node to see the session details
and the number of lines processed.

Review the Resulting Data

To review the resulting data:

1. In the Designer, in the Models tree view, expand the Oracle Target Model.
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2. Select the W_GEO_DS datastore, right-click and select Data to view the data
integrated into the target Oracle table.
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Going Further with Oracle Data Integrator

This chapter describes what steps to take next with Oracle Data Integrator.
You have now completed a project extracting data from a SAP ERP system!
In this project, you have:

= Set up the environment and topology to work with SAP ERP.

»  Created and reverse-engineered a SAP ERP data model

»  Created a mapping to load the data from several joined SAP ERP tables into the
Oracle database.

Note: In case the execution did not complete successfully, please
check the ODI Operator and ODI Logs for details. In addition to this,
the following log files will contain execution information.

m <System Temp Dir or local FTP dir>/ ZODI_<Mapping Id>_
<SrcSet>_<Context>.out

m <System Temp Dir or local FTP dir>/ ZODI_<Mapping Id>_
<SrcSet>_<Context>.err

Refer to section 4.7.6, "Log Files," in Application Adapters Guide for
Oracle Data Integrator for more details.

Refer to the Knowledge Module Developer’s Guide for Oracle Data Integrator for more
information on the SAP ERP KM features and options.

Going further with Oracle Data Integrator

Use the demonstration environment to familiarize yourself with Oracle Data
Integrator. You can go further with Oracle Data Integrator by taking advantage of the
samples available on the Oracle Technology Network.
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SAP ABAP ERP Required Privileges

This appendix lists the required privileges for accessing the SAP system using Oracle
Data Integrator.

An SAP dialog user is required for connecting to the SAP system, for the RKM
installation and for the LKM execution during development. A SAP RFC user is not
sufficient.

During development, this user must have a developer license key. License keys can be
retrieved from http:/ /service.sap.com. Any execution attempts without this developer
license key will lead to failure and may cause the need for clean-up operations.

For RKM and LKM execution in production, an SAP RFC user is sufficient.

These SAP user types can be used for the following operations:

Table A-1 Required SAP User Types

Operation Required SAP User Type

RKM: Setup SAP Dialog user

RKM: Reverse Engineering | SAP Dialog user or SAP RFC user
LKM: Development SAP Dialog user or SAP RFC user
LKM: Production SAP Dialog user or SAP RFC user

The following tables list the privileges required for using SAP ABAP Knowledge
Modules:

= Authorizations Required for RKM SAP ERP Upload

= Authorizations Required for RKM SAP ERP Execution

= Authorizations Required for LKM SAP ERP Upload (Background mode)

= Authorizations Required for LKM SAP ERP Execution (Background mode)
= Authorizations Required for LKM SAP ERP Upload (Dialog mode)

= Authorizations Required for LKM SAP ERP Execution (Dialog mode)

Important points to consider
Consider the following points while configuring the SAP privilieges:

= S_DATASET is an authorization object that controls access to physical file, so you
need to provide access to SAP directories & folder mounted path. The values

SAP ABAP ERP Required Privileges A-1



Authorizations Required for RKM SAP ERP Upload

provided here are sample paths, you need to provide your landscape directories
path or provide *(all).

s NR or (NR) means NOT REQUIRED.

Authorizations Required for RKM SAP ERP Upload

The following SAP authorizations are required for first time installation of the RKM
SAP ERP.

Note: Developer key is required in this authorization.

Object Field Name  Value (4.6¢c) Value (4.7) Value (ECC 5) Value (ECC 6)
S_RFC ACTVT 16
RFC_NAME RFC1,
SDIFRUNTIME,
SUTL, SYST,
ZODI_FGR
RFC_TYPE FUGR
S_TCODE TCD SUS3, SE38
S_ADMI_FCD S_ADMI_FCD MEMO, SM02 SM02 (NR) NR

S_CTS_ADMI CTS_ADMFCT TABL

S_DATASET ACTVT 34
FILENAME \\HYPTESTO1\
sapmnt*
PROGRAM SAPLSLOG,
SAPLSTRF
S_TABU_DIS ACTVT 03 NR
DICBERCLS MA NR
S_DEVELOP ACTVT 01,02,03 16
DEVCLAS $TMP, ZODI_
LKM_PCKG,
ZODI_RKM_
PCKG
OBJNAME 7Z$$SXRFC,
ZODI_FGR,
ZODI_FGR_
PROD, ZODI_
LKM_PCKG,
ZODI_RKM_
PCKG
OBJTYPE DEVC, FUGR, PR
0G
P_GROUP
S_TRANSPRT ACTVT 01,03 03 (NR)
TTYPE DTRA, TASK
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Authorizations Required for RKM SAP ERP Execution

The following SAP authorizations are required for reverse engineering the SAP models
using RKM SAP ERP.

Object Field Name Value (4.6¢c) Value (4.7) Value (ECC 5) Value (ECC 6)
S_RFC ACTVT 16
RFC_NAME RFC1,SDIF,SY SDIFRUNTIME, SDIFRUNTIME, SDIFRUNTIME,
ST,ZODI_FGR  SDIF (NR) SDIF (NR) SDIF (NR)
RFC_TYPE FUGR
S_TCODE TCD SU53
S_TABU_DIS ACTVT 03
DICBERCLS MA CA,SsC

Authorizations Required for LKM SAP ERP Upload (Background mode)

The following SAP authorizations are required for running mappings using the SAP
ERP LKMs in a SAP development environment when LKM option BACKGROUND_
PROCESSING is set to true (recommended default).

Note: Developer Key is required in this authorization.

Object Field Name  Value (4.6¢c) Value (4.7) Value (ECC 5) Value (ECC 6)
S_RFC ACTVT 16
RFC_NAME RFCl, SDIF, SDIFRUNTIME, SDIFRUNTIME, SDIFRUNTIME,
SLST, SYST,  SDIF (NR) SDIF (NR) SDIF (NR)
ZODI*, ZODI_
FGR, ZODI_
FGR_PROD*
RFC_TYPE FUGR
S_TCODE TCD SUS53 SE38 SE38 NR
S_BTCH_ADM BTCADMIN Y
S_BTCH_JOB JOBACTION RELE
JOBGROUP '

S_CTS_ADMI CTS_ADMFCT TABL

S_DATASET ACTVT 06,33,34
FILENAME \\HYPTESTO1\
sapmnt*
PROGRAM SAPLSLOG,
SAPLSTRF,
SAPLZODI*,
ZODI*
S_DEVELOP ACTVT 01 02,03,06,16 02,03,06,16
DEVCLASS
OBJNAME ZODI_FGR_ ZANU* ZANU*
PROD*
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Object Field Name  Value (4.6¢c) Value (4.7) Value (ECC 5) Value (ECC 6)
OBJTYPE FUGR PROG
P_GROUP
S_PROGRAM P_ACTION NR EDIT, NR
SUBMIT,
VARIANT
P_GROUP NR NR
S_TRANSPRT ACTVT 01,02,03 03 (NR) 03 (NR)
TTYPE DTRA, TASK

Authorizations Required for LKM SAP ERP Execution (Background mode)

The following SAP authorizations are required for running mappings using the SAP
ERP LKMs in a SAP production environment when LKM option BACKGROUND_
PROCESSING is set to true (recommended default).

Object Field Name  Value (4.6¢c) Value (4.7) Value (ECC 5) Value (ECC 6)
S_RFC ACTVT 16
RFC_NAME RFC1, SLST SLST SLST
SDIFRUNTIME,
SYST, ZODI_
FGR_PROD*
RFC_TYPE FUGR
S_TCODE TCD SuUs3
S_BTCH_ADM BTCADMIN Y
S_BTCH_JOB JOBACTION RELE
JOBGROUP '
S_DATASET ACTVT 06,33,34
FILENAME \\HYPTEST01\
sapmnt*
PROGRAM SAPLSLOG, (SAPLSLOG, (SAPLSLOG, (SAPLSLOG,
SAPLSTRF, SAPLSTRF, SAPLSTRF, SAPLSTRF,
SAPLZODI*, SAPLZODI*) SAPLZODI*) SAPLZODI¥)
ZODI* NR NR NR

Authorizations Required for LKM SAP ERP Upload (Dialog mode)

The following SAP authorizations are required for running mappings using the SAP
ERP LKMs in a SAP development environment when LKM option BACKGROUND_
PROCESSING is set to false (non-default).

Note: Developer Key is required in this authorization.

Object Field Name Value (4.6¢c) Value (4.7) Value (ECC 5) Value (ECC 6)

S_RFC ACTVT 16
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Object Field Name  Value (4.6¢c) Value (4.7) Value (ECC 5) Value (ECC 6)
RFC_NAME RFC1,
SDIFRUNTIME,
SYST, ZODI_
FGR, ZODI_
FGR_PROD*
RFC_TYPE FUGR
S_TCODE TCD SUS3, SE38
S_DATASET ACTVT 06,33,34
FILENAME \\HYPTEST01\
sapmnt*
PROGRAM SAPLSLOG,
SAPLSTRF,
SAPLZODI*,
ZODI*
S_DEVELOP ACTVT 01 02,03,06 02,03,06
DEVCLASS
OBJNAME ZODI_FGR_
PROD*
OBJTYPE FUGR PROG
P_GROUP
S_PROGRAM P_ACTION NR EDIT, EDIT, NR
SUBMIT, SUBMIT,
VARIANT VARIANT
P_GROUP NR
S_TRANSPRT ACTVT 01
TTYPE DTRA, TASK

Authorizations Required for LKM SAP ERP Execution (Dialog mode)

The following SAP authorizations are required for running mappings using the SAP
ERP LKMs in a SAP production environment when LKM option BACKGROUND_
PROCESSING is set to false (non-default).

Object Field Name Value (4.6¢c) Value (4.7) Value (ECC 5) Value (ECC 6)
S_RFC ACTVT 16
RFC_NAME RFC1,SDIF,SY SDIFRUNTIME, SDIFRUNTIME, SDIFRUNTIME,
ST, ZODI* SDIF (NR) SDIF (NR) SDIF (NR)
RFC_TYPE FUGR
S_TCODE TCD SU53
S_DATASET ACTVT 06,33,34
FILENAME *\\DEL-7TMK2
BS\odiagentb
ox*,
\\DEL-7TMK2B
S\odiagentbo
X
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Object Field Name  Value (4.6¢c) Value (4.7) Value (ECC 5) Value (ECC 6)
PROGRAM SAPLSLOG*,
SAPLSTRF*,
SAPLZODI*
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SAP Stand-Alone Connection Test

This appendix describes how to perform an SAP stand-alone connection test.

In addition to the Connection Testing described above, a test can be performed outside
of ODI using a standalone java utility.

SAP Stand-Alone Connection Test

To use a standalone java utility to test the connection:

1. Open a command window.

2. Change to <ODI_HOME>/odi/sdk/1ib directory.

3. Make sure that JAVA_HOME points to a JVM (at least 1.5).
4

Make sure that you have installed SAP Java Connector and that the sapjco3.jar
and the sapjco3 library are in the <ODI_HOME>/odi/sdk/1ib directory.

5. Launch the utility using the following command:
On Windows:
java -cp sapjco3.jar;odi-sap.jar oracle.odi.sap.km.test.JCoTest
On Linux/UNIX:
java -cp sapjco3.jar:odi-sap.jar oracle.odi.sap.km.test.JCoTest

This should result in an output similar to this:

ctHybMame: “<EAP fApplicatdon Server?® not Found
Fo

6. Use a text editor to open the ODI_SAP_CON_POOL. jcoDestination file in the
oracledi/drivers directory. The file should look like this:

#for tests only!
jco.client.lang=EN
jco.destination.peak_limit=10
jco.client.client=800
jco.client.passwd=<SAP Password>
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jco.client.user=<SAP User>
jco.client.sysnr=00
jco.destination.pool_capacity=5
jco.client.ashost=<SAP Application Server>

7. Enter your SAP connection information, which you have received from your SAP
administrator. The file will then look similar to this (use your connection
information!):

#for tests only !
jco.client.lang=EN
jco.destination.peak_limit=10
jco.client.client=800
jco.client.passwd=0DI123
jco.client.user=0DI
jco.client.sysnr=00
jco.destination.pool_capacity=5
jco.client.ashost=123.123.123.123.

8. Launch the utility again using the following command:
On Windows:
java -cp sapjco3.jar;odi-sap.jar oracle.odi.sap.km.test.JCoTest
On Linux/UNIX:
java -cp sapjco3.jar:odi-sap.jar oracle.odi.sap.km.test.JCoTest

This should result in an output similar to this:

MDOWSh system 32 omd.exe

—ep odi-sap.jar;sapjeod.jar oracle.odi.sap.kn.test. . JCoTest

ARG -

ion Pool...

ORI _SAF_COH_FOODL

1108
150H8%Y _1
izo—-HELHY -1

In addition to just testing the SAP connection, the utility will also validate the
existence of certain Function Modules required for the RKM. These are installed
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during first execution of the RKM (UPLOAD_ABAP_CODE and UPLOAD_ABAP_BASE set
to true).

Delete the ODI_SAP_CON_POOL.jcoDestination file after execution, as it contains
the SAP login credentials.

SAP Stand-Alone Connection Test B-3



SAP Stand-Alone Connection Test

B-4 Oracle Fusion Middleware Getting Started with SAP ABAP ERP Adapter for Oracle Data Integrator



C

Uninstalling ODI SAP Components

This appendix describes how to uninstall ODI components from your SAP system.

For removing ODI connectivity from the SAP system, please follow the steps
described in this section.

Please note that this will delete ALL components including generated extractor
programs.

Updating ODI SAP Components

During first-time installation the RKM installs some ODI objects into the SAP system.
This installation consists of two parts: some base objects and some RFCs. When the
RKM options UPLOAD_ABAP_BASE and UPLOAD_ABAP_CODE are both set to true, the base
objects and the RFCs are installed. Such full installation requires that no ODI SAP
objects are installed in the SAP system. See section Uninstalling ODI SAP Components
if needed.

If the ODI objects installed into your SAP systems have been installed by RKM SAP
ERP v32 or later / RKM SAP BW v23 or later, there is no need for reinstalling the base
objects and it is sufficient to update just the RFCs. Reinstalling the RFCs is achieved by
executing a reverse engineering run with RKM option UPLOAD_ABAP_BASE set to false
and RKM option UPLOAD_ABAP_CODE set to true.

Uninstalling ODI SAP Components

To upgrade to a newer ODI SAP Connector release or to permanently remove the ODI
connectivity:

1. Start the SAP GUL

2. Connect to the SAP systems you want to uninstall.

3. Go to the transaction SE80.

4. Select the package or development class option from the drop down box.
5

Enter ZODI_RKM_PCKG in the package or development class field. Note that for
older installations the package name is ZODI_DEVCLASS.

o

Right-click the ZODI_RKM_PCKG object below the object name tab.
7. Select Delete in the drop down menu and delete the development class.

If it does not allow deleting the development class individually, delete all the
objects one by one and then delete the development class.
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8. Go to transaction SE10. Select Modifiable and Workbench Requests. Click
Display.

9. Select the transport requests which have the ODI Objects and Release them.
10. Now repeat the steps 3 to 7 to delete Development Class.

11. Go to transaction SE01. Select Modifiable and Workbench Requests. Click
Display. Release the Transport Request which has ZODI_RKM_PCKG.

12. Repeat Step 4 to 11 for package ZODI_LKM_PCKG.
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